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Chapter 2: Working with NASIS Windows, Menus 
and Toolbars 

The NASIS Window Environment 
The NASIS 6.1 application is designed around a Microsoft Windows graphical user interface 
(GUI). Users can manipulate the application by means of toolbars (icons and buttons) and menu 
selections using a pointing device, such as a mouse. Shortcut keys are enabled for most toolbar 
and menu actions, allowing users to manipulate the application directly from the keyboard as 
well. Like any other Windows application, the NASIS interface includes a variety of controls to 
customize the look and feel of the application to suit a user’s particular preferences. 
 
This chapter introduces the NASIS application window and describes the various panels, 
menus, toolbars, and other controls.   

Learning the Parts of the NASIS Window 
To start NASIS 6.1, click on the Windows ―Start‖ button and select ―All Programs, USDA 
Applications, Soils, NASIS.‖  This link can be set as a desktop shortcut or pinned to the Start 
Menu. 
 
After the NASIS window opens, use the graphic on page 2-2 to identify the various parts of the 
application window.  Notice the familiar parts of a Windows application title bar, such as 
minimize, maximize, and close buttons in the upper right corner of the window. Below the title 
bar is the menu bar and below the menu bar are one or more toolbars. At the bottom of the 
window is the status bar. 
 
The NASIS application window includes three primary panels: the Explorer Panel, the Editor 
Panel, and the Message Panel. The six NASIS object types are accessible from the Explorer 
Panel: Queries, Tables, Reports, Interpretations, Calculations/Validations, and Exports. NASIS 
objects are selected from the Explorer Panel and opened and worked on in the Editor Panel.    
 
The menu bar includes four menus: the NASIS Menu, the Explorer Menu, the Editor Menu, and 
the Help Menu. There are four toolbars: the NASIS Toolbar, the Explorer Toolbar, the Editor 
Toolbar, and the Table Toolbar.  The Explorer Menu and Toolbar change depending on which 
object has the focus in the Explorer Panel.  There is a separate Explorer Menu and Toolbar for 
each of the six NASIS object types. Also, the Editor Menu and Toolbar change depending on 
the object that is opened in the Editor Panel.  Notice that some menu items and toolbar buttons 
are ―grayed out,‖ which means they are not active. Items and buttons will be active or not, 
depending on the changing context of view within the application window, as described in this 
chapter. 
 
Navigation, menu, toolbar, and other controls described in this chapter refer to the use of the 
mouse. Keyboard ―hot keys,‖ which are available to do most everything that can be done with 
the mouse, are listed at the end of this chapter. Keyboard shortcuts for menu items are also 
displayed within the menus.  
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Opening Screen: 
 

 
 

 The title bar contains the maximize, minimize, and close icons. 

 There are three panels within the NASIS window: the Explorer, Editor, and Message 
Panels.  

 There are four basic menus: the NASIS, Explorer, Editor, and Help Menus. 

 There are four toolbars in NASIS: the NASIS, Explorer, Editor, and Table Toolbars.  

 There are six objects: Queries, Tables, Reports, Interpretations, 
Calculations/Validations, and Exports. 

 Upon first starting NASIS, the NASIS Toolbar is visible by default. This and other 
toolbars can be customized to user specifications. 
 

Menu bar 

NASIS toolbar 

Editor Panel 

Close window 

Maximize window 

Minimize window 

Explorer 
Panel 
 

Objects 

Message Panel 
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Explorer Panel 
 

The Explorer Panel provides navigation between the NASIS object types (Queries, Tables, 
Reports, Interpretations, Calculations/Validations, and Exports) and subobjects.  The items 
displayed in the panel change depending on which object is selected at the bottom of the panel.  
The various items are arranged in a ―tree‖ fashion similar to file folders in Windows Explorer. 
The respective Explorer Toolbar for each object type is displayed at the top of the Explorer 
Panel. 
 
The width of the Explorer Panel can be varied by clicking and dragging the right margin of the 
panel.  The panel can be minimized (or made to auto-hide) by clicking the double-arrow button 
in its upper right corner and returned to maximum view using the same button.  These actions 
provide more or less screen territory for the Editor Panel. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click and drag 
margin to vary 
panel width 

Click double-arrow to 
minimize/maximize panel 
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Editor Panel 
 

The Editor Panel is the area of the application window where an open NASIS object is 
displayed and manipulated.  Multiple objects can be opened in the Editor Panel at the same 
time. Each open object is contained within a separate tab across the top of the Editor Panel. 
The name on each tab identifies the object, and the icon at the left on each tab indicates the 
object type. An open object that has the focus can be closed by clicking the ―x‖ at the upper 
right of the Editor Panel (not to be confused with the ―x‖ in the bright red box at the right end of 
the window title bar which, when clicked, closes the NASIS application). 
 
The Editor Menu and Toolbar change depending on the type of object contained in the tab that 
has the focus in the Editor Panel. The NASIS application includes an Editor Menu and Toolbar 
for each of the six primary NASIS object types: Queries, Tables, Reports, Interpretations, 
Calculations/Validations, and Exports.  
 
In the graphic on the following page, notice that the Editor Panel contains the following open 
objects: Table-―Mapunit,‖ Query-―Area/Mapunit/Datamapunit…,‖ Report-―UTIL – Comparison 
…,‖ and Interpretation Rule-―ENG  – Dwellings With Basements.‖  Note the icons 
corresponding to each object type displayed to the left of the object name in each tab. Notice 
also that the table ―Mapunit‖ has the focus. 
 
When the focus in the Editor Panel is on a table object, a series of buttons become visible at 
the bottom of the panel. These buttons provide a variety of table navigation and edit functions. 
The NASIS application window also displays a Table Toolbar when the focus is on a table 
object.  
 
The Editor Menus and Toolbars and Table Toolbar are described later in this chapter. 
 
(No significant screen changes were made between 6.0 and 6.1.) 
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Message Panel 
The Message Panel provides information on the status and results of active and completed 
application processes, such as querying data, running reports, copy/paste operations, local and 
upload conflicts, validations, and synchronizing data. It displays one of the four message 
panels: Status Messages, Local Conflicts, Upload Conflicts, or Validation Results. To change to 
another message panel, click on the tab for that panel at the bottom of the Message Panel. 
Within each tab, messages accumulate throughout the NASIS session. The most current 
information is always at the bottom. At the right side of the Message Panel is a toolbar to assist 
in the management of the messages.   
 
Clicking on the ―pushpin‖ icon at the right of the Message Panel title bar (blue bar) turns on 
auto-hide for the panel. If auto-hide is on, the Message Panel will collapse when the focus is on 
the Editor Panel.  Clicking on the ―x‖ at the upper right closes the Message Panel. The panel 
can be restored by going to the NASIS Menu and choosing one of the four message actions. It 
may also be docked to another location in the NASIS application or undocked to outside the 
application window by dragging the title bar to a new location. ―Anchor points‖ appear when the 
panel is being moved. They show locations within the application window where the panel can 
be docked. 
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NASIS Toolbar and Menu 
The NASIS Toolbar and Menu provide basic functions for managing the data in the local 
database and selected set. 
 

 
 

Each menu has a corresponding toolbar icon.  
The menu contains the icon and a label for each 
menu choice.  Placing the mouse over a menu 
item brings a tool tip (mouse over) with a brief 
description of the item’s function. 
 
The NASIS Menu is static.  It contains the 
general functions common to all Explorer panels. 
The NASIS Menu has four main sections:   
 

1. Operations dealing with the database, 
 

2. Operations dealing with the Message 
Panel,  
 

3. One menu option to manage the user 
profile and default group and two menu 
options to manage the look and feel of the 
user interface, and 
 

4. The option to import pedon data via 
PedonPC or Rapid Carbon spreadsheets. 

The new icons and menu options in NASIS 6.1 
include ―Prepare for Disconnected Editing‖ and 
―Import Excel Files.‖ 

 
The ―Manage User Profile…‖ item is used 
to maintain the user phone number, email 
address, and default NASIS group. Verify 
that all data are populated and a default 
NASIS group is assigned. 

 
 

1 

2 

3 

4 
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Explorer Toolbars and Menus 
 
Each Explorer Toolbar and Menu includes an item for changing the focus of the Explorer Panel 
to a different NASIS object type, thereby changing the Explorer Toolbar and Menu to the 
corresponding toolbar and menu. The Explorer Toolbars and Menus are tailored to the needs of 
the specific object type that has the focus in the Explorer Panel.  In the menus, each item 
includes the shortcut keys that can be used to execute the action directly from the keyboard. 
Each toolbar and menu also has a ―View Information‖ item to open the NASIS Help Menu and 
display data dictionary information about the object. 
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Queries Explorer Toolbar and Menu 
 
The Queries Explorer Toolbar and Menu provides the tools necessary to manage and run a 
query.  Toolbar icons and menu items are highlighted or dimmed based on the user’s actions.  
The Queries Explorer Toolbar is above the Explorer Panel. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
In the Queries Explorer Panel, check boxes allow 
viewing only those queries that are ―ready to use‖ 
and/or that are ―checked out.‖ 
 
Note that the Queries Explorer Panel contains a 
Favorites folder.  This folder allows the user to 
identify and manage frequently used queries from 
any site.  Menu and icon choices are available to 
add or remove queries in the Favorites folder. 
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Tables Explorer Toolbar and Menu 
 
The Tables Explorer Toolbar and Menu are used to open the selected table in the Editor Panel. 
The Tables Explorer Toolbar is above the Explorer Panel. 
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Reports Explorer Toolbar and Menu 
 
The Reports Explorer Toolbar and Menu are used to manage and run a report.  Toolbar icons 
and menu items are highlighted or dimmed based on the user’s actions. The Reports Explorer 
Toolbar is above the Explorer Panel.  
 

 

In the Reports Explorer Panel, check boxes allow 
viewing only those reports that are ―ready to use‖ 
and/or that are ―checked out.‖ 
 
Note that the Reports Explorer Panel contains a 
Favorites folder.  This folder allows the user to 
identify and manage frequently used reports from 
any site.  Menu and icon choices are available to 
add or remove reports in the Favorites folder. 
 
NASIS 6.1 includes the ability for a report to be 
run offline against the national database.  This 
feature allows the user to send a report to the 
national server and retrieve the result via email.  
This process releases the NASIS screen, 
allowing the user to continue work. 
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Interpretations Explorer Toolbar and Menu 
 
The Interpretations Explorer Toolbar and Menu are used to manage the rules, evaluations, and 
properties that constitute interpretations.  Toolbar icons and menu items are highlighted or 
dimmed based on the user’s actions. The Interpretations Explorer Toolbar is above the Explorer 
Panel. 
 

 

 
 

 

 

 

 

 

 

 

 
In the Interpretations Explorer Panel, check boxes 
allow viewing only those interpretation components 
that are ―ready to use,‖ ―primary rules,‖ and/or 
―checked out.‖ 
 
The rules, evaluations, and properties are downloaded 
to the local database as a function of the initialization 
of the database and when the local database is 
refreshed.  All interpretations are available and can be 
run against the local database independent of a report.  
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Calculations/Validations Explorer Toolbar and Menu 
 
The Calculations/Validations Explorer Toolbar and Menu are used to manage calculations and 
validations by those with permission and to run calculations and validations by all users. Toolbar 
icons and menu items are highlighted or dimmed based on the user’s actions. The 
Calculations/Validations Explorer Toolbar is above the Explorer Panel.  
 

 

 
As described later in this chapter, calculations and 
validations are run against a subset of the 
selected set (specific rows that are selected in the 
Table Editor).  
 
In NASIS 6.1, two options were added to this 
object.  The user can run a single calculation or 
validation or run multiple calculations or 
validations concurrently.  In addition, calculations 
and validations can be run on the highlighted 
records or run on all rows in the selected set.   
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Exports Explorer Toolbar and Menu 
 
The Exports Explorer Toolbar and Menu are used to define export parameters and otherwise 
manage exports. Toolbar icons and menu items are highlighted or dimmed based on the user’s 
actions. The Exports Explorer Toolbar is above the Explorer Panel. 
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Editor Toolbar and Menus 
 
The Editor Toolbars and Menus are designed to assist the user in editing the specific object 
types in the Explorer Panel. There is a separate Editor Toolbar and Menu for each NASIS object 
type. Every item in a menu has a corresponding button on the toolbar that performs the same 
action. In the menus, each item displays the shortcut keys that can be used to execute the 
action directly from the keyboard. Each toolbar and menu also has a ―View Information‖ item to 
open the NASIS Help Menu and display data dictionary information about the object. 
 
The Editor Toolbar and Menu that are displayed change depending on the object type that has 
the focus in the Editor Panel. Toolbar buttons and menu items are highlighted or dimmed based 
on the user’s actions. 

Query Editor Toolbar and Menu 
The Query Editor Toolbar and Menu provides the tools necessary to manage and execute 
NASIS queries. The Editor Toolbar is above the Edit Panel (by default).  

 
The Query Editor Toolbar and Menu allows a 
user to add a new query or edit an existing query. 
An existing query is opened in the Editor Panel 
using the Queries Explorer Menu or Toolbar or by 
double clicking on the query name in the Queries 
Explorer Panel. If a query is selected in the 
Queries Explorer Panel, the query can be marked 
or unmarked for deletion, using the ―Marked for 
Deletion‖ option or the ―Remove the Deletion 
Mark‖ option.  If a query is open in the Editor 
Panel, the user can simply save the query edits 
(―Save‖ option) or save the edits under a new 
report name (―Save As‖ option), thus preserving 
the original query.  When editing a query, the 
user has the familiar copy, cut, paste, undo, redo, 
and find/replace functions.   
 
From both the menu and the toolbar, a user can 
run the selected query against the local database 
or run the selected query against the national 
database. Also, the user can choose to add the 
selected query to or delete it from the Favorites 
list. 
 
Right clicking on the query name in the Explorer 
Panel displays the menu used to execute many of 
the above actions. 
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Table Editor Toolbar and Menu and Table Toolbar 
 
The Table Editor Toolbar and Menu and the Table Toolbar provide the tools necessary to 
manage tables in the Editor Panel and create records and edit data in a table. The Table Editor 
Toolbar is above the Editor Panel (by default). The Table Editor Toolbar and the Table Toolbar 
are similar toolbars. The Table Toolbar is functional only when a table has the focus in the 
Editor Panel.  
 

The Table Editor Toolbar and Menu and the Table 
Toolbar allow a user to close the table and use the 
familiar copy, cut, paste, undo, redo, and 
find/replace options.  Additional functions are 
available to manipulate the data within the table.  
New rows can be added, a cell can be cleared, 
rows can be marked or unmarked for deletion, and 
data can be copied, cut, and pasted by the row or 
by the ―tree.‖  The specific parent row can be 
copied or the parent row and all associated child 
rows (a tree) can be copied.  The ―Find Related for 
Current Row…‖ option is useful when the Mapunit 
table is open and the user wants to go directly to 
the data for a specific map unit. A use can simply 
open the Correlation table, highlight the map unit 
correlation record, and choose ―Find Related.‖  The 
―Load Related for Current Row…‖ option is useful if 
additional data needs to be loaded from the local 
database into the selected set.  The ―Change 
Owner of Selected Rows…‖ option allows the user 
to change ownership.  The user can highlight rows 
to be removed from the selected set.  The ―View 
Information‖ option provides information on the 
selected table. 

 

Table Toolbar 

Table Editor 
Toolbar 
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Report Editor Toolbar and Menu 
 
The Report Editor Toolbar and Menu provide the tools necessary to manage reports. The 
Report Editor Toolbar is above the Editor Panel (by default).  
 

 

An existing report is opened in the Editor Panel 
using the Reports Explorer Toolbar or Menu or by 
double clicking on the report name in the Reports 
Explorer Panel.  The Report Editor Toolbar and 
Menu allow a user to create a new report.  A user 
can simply save the report edits (―Save‖ option) 
or save the edits under a new report name (―Save 
As‖ option), thus preserving the original report.  
The user can close a selected report.  When 
editing a report, the user has the familiar copy, 
cut, paste, undo, redo, and find/replace functions.   
 
The user can also choose ―Run Against Local 
Database‖ or ―Run Against National Database.‖  
The user can view information about the report 
table.  In addition, the user can choose to add the 
selected report to the Favorites list or remove it 
from that list. 
 
NOTE: Use caution when running reports against 
the national database.  Reports run against the 
national database should include filters specific to 
the data needed. 
 

If a report is selected in the Reports Explorer 
Panel, the user can mark that report for deletion 
or remove the deletion mark. 
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Interpretation Editor Toolbar and Menu 
 
The Interpretation Editor Toolbar and Menu provide the tools necessary to manage 
interpretation rules, evaluations, and properties.  The Interpretation Editor Toolbar is above the 
Editor Panel (by default).  
 

 
 

An existing interpretation rule, evaluation, or 
property is opened in the Editor Panel using the 
Interpretation Explorer Toolbar or Menu. The 
Interpretation Editor Toolbar and Menu also allow 
a user to create a new rule, evaluation, or 
property. A user can simply save the edits 
(―Save‖ option) or save the edits under a new 
report name (―Save As‖ option), thus preserving 
the original version. When editing a rule, 
evaluation, or property, a user has the familiar 
copy, cut, paste, undo, redo, and find/replace 
functions. The user can also choose to see the 
results of the interpretation by choosing ―Run 
Against the Local Database.‖ 
 
If a rule, evaluation, or property is selected in the 
Interpretation Explorer Panel, the user can mark 
that object for deletion or remove the deletion 
mark.   
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Calculation and Validation Editor Toolbar and Menu 
 
The Calculation/Validation Editor Toolbar and Menu provide the tools necessary to manage 
NASIS calculations and validations.  The Calculation/Validation Editor Toolbar is above the 
Editor Panel (by default).  

 
 
 

 
An existing calculation or 
validation is opened in the Editor 
Panel using the 
Calculation/Validation Explorer 
Toolbar or Menu. The 
Calculation/Validation Editor 
Toolbar and Menu also allow an 
authorized user to create a new 
calculation or validation. An 
authorized user can simply save 
the edits (―Save‖ option) or save 
the edits under a new report 
name (―Save As‖ option), thus 
preserving the original 
calculation or validation. When 
editing a calculation, the user 
has the familiar copy, cut, paste, 
undo, redo, and find/replace 
functions.   
    
Any user can run the selected 
calculation or validation by 
choosing ―Run Against Local 
Database.‖ Calculations and 
validations are run against a 
subset of the selected set 

(specific rows that are selected in the Table Editor). The ―Run for Highlighted Rows‖ and ―Run 
for All Rows in Selected Set‖ menu items run the calculation or validation against the 
appropriate data, not against the entire local database. 
 
If a calculation or validation is selected in the Calculation/Validation Explorer Panel, an 
authorized user can mark that calculation or validation for deletion or remove the deletion mark. 
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Export Editor Toolbar and Menu 
 
The Export Editor Toolbar and Menu provide the tools necessary to manage NASIS export.  The 
Export Editor Toolbar is above the Editor Panel (by default).  
 
An existing export is opened in the Editor Panel by double clicking on the export in the Export 
Explorer Panel. The Export Editor Toolbar and Menu allow the user to create a new export. The 
Export Editor Panel is used to identify the export target and the specific export parameters and 
to run the export. The Export Editor Panel has four tabs that allow the user to set the export 
parameters, identify the interpretations and text field to include with the export, and to run the 
export. All users can run SSURGO exports. Only authorized users can run Staging Server 
exports.  
 

 
 
 
 
 

 

 
 

NASIS 6.1 provides the ability 
to assign a specific ―Export 
File Name.‖ 
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NASIS Help Menu 
 
Two forms of help are available from the NASIS application window: online documentation and 
data dictionary information about specific NASIS objects. The Help Menu provides access to 
NASIS online documentation maintained on the NRCS Soils website. The Help Menu also 
allows a user to send error reports to the NASIS hotline.  
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
Data dictionary information about NASIS objects is accessed two ways. All Explorer and Editor 
Toolbars and Menus have a ―View Information‖ choice. Right clicking on an object name in the 
Explorer Panel and on 
column headers and 
other key places in the 
Editor Panel displays 
pop-up menus that also 
have a ―View 
Information‖ choice. In 
this graphic, right 
clicking on 
―Geomorphic Feature‖ 
from the Tables 
Explorer Panel displays 
the pop-up menu and 
the ―View Information‖ 
choice.  
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The ―View Information‖ choice opens a browser window and displays detailed information 
contained in the NASIS data dictionary about the target object. Hyperlinks within the browser 
point to additional information. The graphic below illustrates the Geomorphic Feature Type table 
accessed from the View Menu.  
 

 
 
Because it takes a few moments for the View Information browser window to open, once it is 
opened it should be left open for the duration of the NASIS session so that later access to 
information is faster.  
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Managing NASIS Toolbars 

 

NASIS users have a number of options for managing and customizing toolbars in NASIS. 
Toolbars can be hidden or docked in new locations within the application window and toolbar 
buttons can be removed, added, and reordered. Choose the ―Manage Toolbars‖ item from the 
NASIS Menu or the button on the NASIS Toolbar (see red arrow in the following graphic). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

From the Manage Toolbars dialog box, 
select a toolbar to manage.  
 
 
 
 
 
 
The toolbar can be hidden (using ―Never 
display this toolbar‖). The toolbar’s 
buttons can be hidden (using ―Hide Tool‖) 
or rearranged (using ―Move Up‖ and 
―Move Down‖). 
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Finally, the toolbar can be docked 
in a different location (using 
―Choose that toolbar’s location‖). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Because menu items are available for all toolbar buttons, all toolbar actions are still available to 
the user when a toolbar is hidden. Hiding a toolbar can help increase the amount of screen 
available for the Explorer, Editor, and Message Panels. The following graphic shows the 
application window with the toolbars hidden.  
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The following graphic shows the application window with the toolbars hidden, ―auto-hide‖ turned 
on for the Explorer Panel, the Message Panel docked on the right side, and ―auto-hide‖ turned 
on for the Message Panel.  

 
 



NASIS User Guide 

Chapter 2: Working with NASIS Windows, Menus and Toolbars 
(Version 6.1, November 2011) 

2-27 

NASIS Shortcut Keys 
 

Explorer Menus Editor Menus Table Menus 
Ctrl + Shift + A  Ctrl + A Select All Alt + Shift + A  

Ctrl + Shift + B  Ctrl + B  Alt + Shift + B  

Ctrl + Shift + C Explore Calcs Ctrl + C Copy Alt + Shift + C  

Ctrl + Shift + D  Ctrl + D  Alt + Shift + D Delete 

Ctrl + Shift + E Explore Exports Ctrl + E  Alt + Shift + E  

Ctrl + Shift + F 
Add/Remove 
Favorite 

Ctrl + F 
Add/Remove 
Favorite 

Alt + Shift + F  

Ctrl + Shift + G 
View Checkout 
Status 

Ctrl + G 
View Checkout 
Status 

Alt + Shift + G 
View Checkout 
Status 

Ctrl + Shift + H View Information Ctrl + H View Information Alt + Shift + H  

Ctrl + Shift + I Explore Interps Ctrl + I  Alt + Shift + I  

Ctrl + Shift + J Check In Ctrl + J Check In Alt + Shift + J Check In 

Ctrl + Shift + K Check Out Ctrl + K Check Out Alt + Shift + K Check Out 

Ctrl + Shift + L Run Local Ctrl + L Run Local Alt + Shift + U Undelete 

Ctrl + Shift + M Delete/Undelete Ctrl + M Delete/Undelete Alt + Shift + V  

Ctrl + Shift + N Run National Ctrl + N Run National Alt + Shift + W 
View Where 
Used 

Ctrl + Shift + O Open Ctrl + O  Alt + Shift + Y  

Ctrl + Shift + P  Ctrl + P  Alt + Shift + Z  

Ctrl + Shift + Q Explore Queries Ctrl + Q  F2 * Edit Cell 

Ctrl + Shift + R Explore Reports Ctrl + R Find/Replace F4 
* Open/Close  
  Choice List 

Ctrl + Shift + S  Ctrl + S Save Ctrl + Insert Add Row 

Ctrl + Shift + T Explore Tables Ctrl + T  Ctrl + Delete Clear Cell 

Ctrl + Shift + U  Ctrl + U  F5 Copy Rows 

Ctrl + Shift + V  Ctrl + V Paste F6 Copy Trees 

Ctrl + Shift + W View Where Used Ctrl + W View Where Used Shift + F5 Cut Rows 

Ctrl + Shift + X  Ctrl + X Cut Shift + F6 Cut Trees 

Ctrl + Shift + Y  Ctrl + Y Redo F7 Paste (insert) 

Ctrl + Shift + Z  Ctrl + Z Undo Shift + F7 Paste (replace) 

 
* Functions not listed on the menus and toolbars. 
F2—When in a cell of a table, F2 can select the whole cell’s contents or activate the text cursor for editing 
in the cell. 
F4—When a cell of a table has a drop-down choice list or text editing box, F4 opens or closes this 
list/box. 
 


